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This document provides instructions for integrating the Avaya S8300, Avaya S8500, or Avaya S8700 
phone system (hereafter referred to as the Avaya S8700 phone system) with Cisco Unity by using PIMG 
units (media gateways).

Integration Tasks
Before doing the following tasks to integrate Cisco Unity with the Avaya S8700 phone system by using 
PIMG units, confirm that the Cisco Unity server is ready for the integration by completing the applicable 
tasks in the applicable Cisco Unity installation guide.

The following task lists describe the process for creating, changing, and deleting integrations.

Task List to Create the Integration
Use the following task list to set up a new integration with the Avaya S8700 phone system. If you are 
installing a new Cisco Unity server by using the applicable Cisco Unity installation guide, you may have 
already completed some of the following tasks.

1. Review the system and equipment requirements to confirm that all phone system and Cisco Unity 
server requirements have been met. See the “Requirements” section on page 2.

2. Plan how the voice messaging ports will be used by Cisco Unity. See the “Planning How the Voice 
Messaging Ports Will Be Used by Cisco Unity” section on page 5.

3. Program the Avaya S8700 phone system and extensions. See the “Programming the Avaya S8700 
Phone System” section on page 7.

4. Set up the PIMG units. See the “Setting Up the PIMG Units” section on page 9.

5. Create the integration. See the “Creating a New Integration with the Avaya S8700 Phone System” 
section on page 17.
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Requirements
Caution Do not edit the phone configuration file (also known as the switch ini file) to customize this 
integration. If you change the settings in this file, the integration may not function correctly.

6. Test the integration. See the “Testing the Integration” section on page 21.

7. (Cisco Unity 4.1 and later) If you have a secondary server for Cisco Unity failover, integrate the 
secondary server. See the “Integrating a Secondary Server for Cisco Unity Failover” section on 
page 24.

Task List to Make Changes to an Integration
Use the following task list to make changes to an integration after it has been created.

1. Start the Cisco Unity Telephony Integration Manager (UTIM). See the “Changing the Settings for 
an Existing Integration” section on page 26.

2. Make the changes you want to the existing integration. See the “Changing the Settings for an 
Existing Integration” section on page 26.

Caution Do not edit the phone configuration file (also known as the switch ini file) to customize this 
integration. If you change the settings in this file, the integration may not function correctly.

Task List to Delete an Existing Integration
Use the following task list to remove an existing integration.

1. Start the Cisco Unity Telephony Integration Manager (UTIM). See the “Deleting an Existing 
Integration” section on page 27.

2. Delete the existing integration. See the “Deleting an Existing Integration” section on page 27.

Requirements
The Avaya S8700 integration supports configurations of the following components:

Phone System

• An Avaya S8300, Avaya S8500, or Avaya S8700 phone system.

• Software version Communication Manager 2.0.

• One or more of the applicable PIMG units. For details, refer to the “Supported Circuit-Switched 
Phone System Integrations” section in the applicable Supported Hardware and Software, and 
Support Policies at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html.

• The voice messaging ports in the phone system connected by digital lines to the ports on the PIMG 
units.
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Requirements
We recommend that you connect the voice messaging ports on the phone system to the ports on the 
PIMG units in a planned manner to simplify troubleshooting. For example, the first phone system 
voice messaging port connects to the first port on the first PIMG unit, the second phone system voice 
messaging port connects to the second port on the first PIMG unit, and so on.

• The PIMG units connected to the same LAN or WAN that Cisco Unity is connected to.

• If the PIMG units connect to a WAN, the requirements for the WAN network connections are:

– For G.729a codec formatting, a minimum of 32.76 Kbps guaranteed bandwidth for each voice 
messaging port.

Caution If you use G.729a codec formatting over a WAN, you must disable comfort noise. Otherwise, 
callers will hear loud comfort noise at certain points. For details, see the “Appendix: PIMG 
Integrations Over a WAN That Use the G.729a Codec Must Disable Comfort Noise” section 
on page 32.

– For G.711 codec formatting, a minimum of 91.56 Kbps guaranteed bandwidth for each voice 
messaging port.

– No network devices that implement network address translation (NAT).

– A maximum 200 ms network latency.

• The phone system ready for the integration, as described in the documentation for the phone system.

Cisco Unity Server

• Cisco Unity installed and ready for the integration, as described in the applicable Cisco Unity 
installation guide at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html.

• A license that enables the applicable number of voice messaging ports.
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Integration Description
Integration Description
The Avaya S8700 PIMG integration sends call information and voice connections through the digital 
lines, which connect the phone system to the PIMG units. The PIMG units communicate with the 
Cisco Unity server through the LAN or WAN by using Session Initiation Protocol (SIP). Figure 1 shows 
the required connections.

Figure 1 Connections Between the Phone System and Cisco Unity

Call Information
The phone system sends the following information with forwarded calls:

• The extension of the called party

• The extension of the calling party (for internal calls) or the phone number of the calling party (if it 
is an external call and the system uses caller ID)

• The reason for the forward (the extension is busy, does not answer, or is set to forward all calls)

Cisco Unity uses this information to answer the call appropriately. For example, a call forwarded to 
Cisco Unity is answered with the personal greeting of the subscriber. If the phone system routes the call 
to Cisco Unity without this information, Cisco Unity answers with the opening greeting.

Integration Functionality
The Avaya S8700 integration with Cisco Unity provides the following integration features:

• Call forward to personal greeting

• Call forward to busy greeting

• Caller ID

• Easy message access (a subscriber can retrieve messages without entering an ID because 
Cisco Unity identifies the subscriber based on the extension from which the call originated; a 
password may be required)

Digital lines
Network connections

Phone system Cisco Unity server

10
40

43

LAN/WAN
PIMG unit

Additional
PIMG units
as needed

PIMG unit
4
Avaya S8500/S8700 PIMG Integration Guide for Cisco Unity 4.0

OL-8239-16



 

Avaya S8500/S8700 PIMG Integration Guide for Cisco Unity 4.0
Planning How the Voice Messaging Ports Will Be Used by Cisco Unity
• Identified subscriber messaging (Cisco Unity identifies the subscriber who leaves a message during 
a forwarded internal call, based on the extension from which the call originated)

• Message waiting indication (MWI)

Integrations with Multiple Phone Systems
Depending on the version, Cisco Unity can be integrated with two or more phone systems:

• Cisco Unity 4.0 and 4.1 can be integrated with a maximum of two phone systems at one time. For 
information on and instructions for integrating Cisco Unity with two phone systems, refer to the 
Dual Phone System Integration Guide at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_configuration_guide09186a00802
11b2e.html.

• Cisco Unity 4.2 and later can be integrated with two or more phone systems at one time. For 
information on the maximum supported combinations and instructions for integrating Cisco Unity 
with multiple phone systems, refer to the Multiple Phone System Integration Guide at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_configuration_guide09186a00806
192a3.html.

Planning How the Voice Messaging Ports Will Be Used by 
Cisco Unity

Before programming the phone system, you need to plan how the voice messaging ports will be used by 
Cisco Unity. The following considerations will affect the programming for the phone system (for 
example, setting up the hunt group or call forwarding for the voice messaging ports):

• The number of voice messaging ports installed.

• The number of voice messaging ports that will answer calls.

• The number of voice messaging ports that will only dial out, for example, to send message 
notification, to set message waiting indicators (MWIs), to make AMIS deliveries, and to make 
telephone record and playback (TRAP) connections.

The following table describes the voice messaging port settings in Cisco Unity that can be set in UTIM, 
and that are displayed as read-only text on the System > Ports page of the Cisco Unity Administrator.

Table 1 Settings for the Voice Messaging Ports

Field Considerations

Extension Enter the extension for the port as assigned on the phone system.

Enabled Check this check box to enable the port. The port is enabled during normal operation.

Uncheck this check box to disable the port. When the port is disabled, calls to the port get a 
ringing tone but are not answered. Typically, the port is disabled only by the installer during 
testing.

Answer Calls Check this check box to designate the port for answering calls. These calls can be incoming 
calls from unidentified callers or from subscribers.

Message Notification Check this check box to designate the port for notifying subscribers of messages. Assign 
Message Notification to the least busy ports.
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The Number of Voice Messaging Ports to Install

The number of voice messaging ports to install depends on numerous factors, including:

• The number of calls Cisco Unity will answer when call traffic is at its peak.

• The expected length of each message that callers will record and that subscribers will listen to.

• The number of subscribers.

• The number of ports that will be set to dial out only.

• The number of calls made for message notification.

• The number of MWIs that will be activated when call traffic is at its peak.

• The number of AMIS delivery calls.

• The number of TRAP connections needed when call traffic is at its peak. (TRAP connections are 
used by Cisco Unity web applications to play back and record over the phone.)

• The number of calls that will use the automated attendant and call handlers when call traffic is at its 
peak.

It is best to install only the number of voice messaging ports that are needed so that system resources are 
not allocated to unused ports.

The Number of Voice Messaging Ports That Will Answer Calls

The calls that the voice messaging ports answer can be incoming calls from unidentified callers or from 
subscribers. Typically, the voice messaging ports that answer calls are the busiest.

You can set voice messaging ports to both answer calls and to dial out (for example, to send message 
notifications). However, when the voice messaging ports perform more than one function and are very 
active (for example, answering many calls), the other functions may be delayed until the voice messaging 
port is free (for example, message notifications cannot be sent until there are fewer calls to answer). For 
best performance, dedicate certain voice messaging ports for only answering incoming calls, and 

Dialout MWI

(not used by serial or SMDI 
integrations)

Check this check box to designate the port for turning MWIs on and off. Assign Dialout MWI 
to the least busy ports.

AMIS Delivery

(available with the AMIS 
licensed feature only)

Check this check box to designate the port for making outbound AMIS calls to deliver voice 
messages from Cisco Unity subscribers to users on another voice messaging system. 
Cisco Unity supports the Audio Messaging Interchange Specification (AMIS) protocol, 
which provides an analog mechanism for transferring voice messages between different 
voice messaging systems.

This setting affects outbound AMIS calls only. All ports are used for incoming AMIS calls.

Because the transmission of outgoing AMIS messages may tie up voice ports for long 
periods of time, you may want to adjust the schedule on the Network > AMIS > Schedule 
page so that outgoing AMIS calls are placed during closed hours or at times when 
Cisco Unity is not processing many calls.

TRAP Connection Check this check box so that subscribers can use the phone as a recording and playback 
device in Cisco Unity web applications and e-mail clients. Assign TRAP Connection to the 
least busy ports.

Table 1 Settings for the Voice Messaging Ports (continued)

Field Considerations
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Programming the Avaya S8700 Phone System
dedicate other ports for only dialing out. Separating these port functions eliminates the possibility of a 
collision, in which an incoming call arrives on a port at the same time that Cisco Unity takes the port 
off-hook to dial out.

The Number of Voice Messaging Ports That Will Only Dial Out, and Not Answer Calls

Ports that will only dial out and will not answer calls can do one or more of the following:

• Notify subscribers by phone, pager, or e-mail of messages that have arrived.

• Turn MWIs on and off for subscriber extensions.

• Make outbound AMIS calls to deliver voice messages from Cisco Unity subscribers to users on 
another voice messaging system. (This action is available only with the AMIS licensed feature.)

• Make a TRAP connection so that subscribers can use the phone as a recording and playback device 
in Cisco Unity web applications.

Typically, these voice messaging ports are the least busy ports.

Caution In programming the phone system, do not send calls to voice messaging ports in Cisco Unity that cannot 
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging 
port is set only to Dialout MWI, do not send calls to it.

Preparing for Programming the Phone System

Record your decisions about the voice messaging ports to guide you in programming the phone system.

Programming the Avaya S8700 Phone System
If you use programming options other than those supplied in the following procedure, the performance 
of the integration may be affected.

Caution In programming the phone system, do not send calls to voice messaging ports in Cisco Unity that cannot 
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging 
port is set only to Dialout MWI, do not send calls to it.

Do the following procedure.

To Program the Avaya S8700 Phone System

Step 1 Create a coverage path which contains the PIMG unit hunt group number as the coverage point.

Step 2 Assign the coverage path that you created in Step 1 to the user stations that must forward to the voice 
messaging ports on the PIMG units when calls are not answered or when the user station is busy, based 
on one of the Cisco Unity call transfer types shown in Table 2.
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Step 3 Use the Add Station <extension number> command (for example, Add Station 2999) to assign an 
extension number for each voice messaging port, which is a digital line that connects to the PIMG unit. 
Set the voice messaging port options (Table 3) and button assignments (Table 4), and press Enter.

Note We recommend that you distribute the voice messaging ports among multiple phone system line 
cards so that call processing can continue even if a line card becomes inactive.

Table 2 Call Transfer Types

Transfer Type Usage

Release transfer
(blind transfer)

Program the user station to forward calls to the pilot number when:

• The extension is busy.

• The call is not answered.

Supervised transfer Program the user station to forward calls to the pilot number only when 
the call is not answered (on the phone system, the number of rings 
before forwarding must be more than the number of rings to supervise 
the call). Confirm that call forwarding is disabled when the extension is 
busy.

Table 3 Voice Messaging Port Options for All Lines

Option Setting

Extension <the extension number of the digital line>

Type 7434ND (recommended)

You can also use the following settings. However, you must 
include the extension with each subscriber name when 
programming the phone system (for example, “3001 Jane Doe”). 
Otherwise, the integration will not function correctly.

• 8434

• 8434D

• 8434DX

Caution If the setting that you want is not available, contact the 
phone system manufacturer.

LWC Activation? y

Restrict Last Appearance? y

Display Module y
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Step 4 Use the Add Hunt <hunt group number> command (for example, Add Hunt 1) to assign a the voice 
messaging ports to a hunt group. Set the following options.

Step 5 Enter the group member assignments for the voice messaging ports that will answer calls and press 
Enter.

If you plan to set the voice messaging ports to either answer calls or to dial out (for example, to set 
MWIs), make sure that you include in the hunt group only the voice messaging ports that will be set to 
answer calls.

For smaller systems, include in the hunt group all voice messaging ports when the ports will be set to 
both answer calls and dial out (for example, to set MWIs).

Note You can use alternate extensions to create multiple line appearances, enable easy message access from 
cell phones, and simplify addressing messages to subscribers at different locations in Cisco Unity. 
Enabling alternate MWIs allows Cisco Unity to turn MWIs on at more than one extension. For details, 
see the “Appendix: Using Alternate Extensions and MWIs” section on page 28.

Setting Up the PIMG Units
Do the following procedures to set up the PIMG units that are connected to the Avaya S8700 phone 
system.

These procedures require that the following tasks have already been completed:

• The phone system is connected to the PIMG units by using digital lines.

• The PIMG units are ready to be connected to the LAN or WAN.

• The PIMG units are connected to a power source.

Table 4 Button Assignments for All Lines

Button Assignment Setting

1 call-appr

2 call-appr

9 lwc-store

10 lwc-cancel

Table 5 Hunt Group Options

Option Setting

Group Number <the hunt group number>

Group Extension <the pilot number for the hunt group>

Group Type ucd

Group Name <the display name for the hunt group>

Queue? N
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Fields that are not mentioned in the following procedures must keep their default values. For the default 
values of all fields, see the documentation for the PIMG unit.

To Download the PIMG Firmware Update Files for Digital PIMG Units

Step 1 On a Windows workstation that will have access to the PIMG units, open a web browser and go to the 
Cisco Unity PIMG Software Download page at 
http://www.cisco.com/cgi-bin/tablebuild.pl/unity-PIMG.

Note To access the software download page, you must be logged on to Cisco.com as a registered user.

Step 2 On the Cisco Unity PIMG Software Download page, click the most recent version of the firmware for 
digital (DNI) PIMG units.

Step 3 On the Details page, click Next.

Step 4 On the Document page, click Accept.

Step 5 In the Enter Network Password dialog box, enter your user name and password, then click OK.

Step 6 In the File Download dialog box, click Save.

Step 7 In the Save As dialog box, browse to the Windows workstation that will have access the PIMG units, 
browse to a directory where you want to save the file, and click Save.

Step 8 In the Download Complete dialog box, click Open. The window for extracting the PIMG firmware 
update files appears.

Step 9 Click Extract.

Step 10 In the Extract dialog box, browse to the directory where you want the extracted files, and click Extract.

Step 11 Close the window for the extracting application.

To Set Up the Digital PIMG Units

Step 1 On the Windows workstation, add a temporary route to enable access to the PIMG units.

a. On the Windows Start menu, click Run.

b. Enter cmd, and press Enter. The Command Prompt window appears.

c. At the command prompt, enter route add 10.12.13.74 <IP Address of Workstation>, and press 
Enter.

For example, if the IP address of the workstation is 198.1.3.25, enter “route add 
10.12.13.74<space>198.1.3.25” in the Command Prompt window.

d. Close the Command Prompt window.

Step 2 Connect a PIMG unit to the network.

Step 3 In the web browser, go to http://10.12.13.74.

Step 4 On the System Login page, enter the following case-sensitive settings.
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Step 5 Click Log On.

Step 6 On the Configure menu, click Upgrade.

Step 7 On the Upgrade page, click Browse.

Step 8 In the Choose File dialog box, browse to the directory on the Windows workstation that has the extracted 
PIMG firmware update files.

Step 9 Click Ami<xx>.app (where <xx> is multiple digits), and click Open.

Step 10 On the Upgrade page, click Install.

Step 11 After the file is installed, a message prompting you to restart the PIMG unit appears. Click Cancel.

Caution Do not restart the PIMG unit until you are instructed to do so later in this procedure, even if 
the file installation fails. Restarting the PIMG unit at this step may prevent the PIMG unit 
from functioning correctly.

Step 12 Repeat Step 6 through Step 11 for each of the following files:

• Ami_<xx>.fsh

• Run<xx>FskEcho.dsp

• iNim<xx>.ibt

• iNim<xx>.ilc

• iNim<xx>.iap

Step 13 On the Configure menu, click Upgrade.

Step 14 On the Upgrade page, click Browse.

Step 15 In the Choose File dialog box, browse to the file DNI_Cfg_Lucent.ini.

Step 16 Click DNI_Cfg_Lucent.ini, and click Open.

Step 17 On the Upgrade page, click Install.

Step 18 After the file is installed, a message prompting you to restart the PIMG unit appears. Click OK.

Step 19 In the web browser, go to http://10.12.13.74.

Step 20 On the System Login page, enter the following case-sensitive settings.

Step 21 Click Log On.

Table 6 System Login Page Settings

Field Setting

Username admin

Password IpodAdmin

Table 7 System Login Page Settings

Field Setting

Username admin

Password IpodAdmin
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Step 22 On the Configure menu, click Password.

Step 23 On the Password page, enter the following settings.

Step 24 Click Change.

Step 25 On the Configure menu, click System.

Step 26 On the System page, enter the following settings.

Step 27 Click Apply Changes.

Step 28 On the Configure menu, click Gateway.

Step 29 On the Gateway page, click the Gateway Routing tab.

Step 30 On the Gateway Routing tab, enter the following settings.

Table 8 Password Page Settings

Field Setting

Old Password IpodAdmin

(This setting is case sensitive.)

New Password <your new password>

(This setting is case sensitive.)

Confirm Password <your new password>

(This setting is case sensitive.)

Table 9 System Page Settings

Field Setting

Operating Mode SIP

Telephony Switch Type Lucent

PCM Coding uLaw

Table 10 Gateway Routing Tab Settings

Field Setting

Fault Tolerance 
Enabled

(Cisco Unity without failover) No

(Cisco Unity with failover configured) Yes

Load Balancing 
Enabled

No

VoIP Endpoint ID:
1

(Cisco Unity without failover) <the IP address of the Cisco Unity server>

(Cisco Unity with failover configured) <the name the primary Cisco Unity 
server; this setting must match the Contact Line Name field setting in UTIM>

VoIP Endpoint ID:
2

(Cisco Unity without failover) <blank>

(Cisco Unity with failover configured) <the name the secondary Cisco Unity 
server; this setting must match the Contact Line Name field setting in UTIM>
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Step 31 Click Apply Changes.

Step 32 Click the Gateway Advanced tab.

Step 33 On the Gateway Advanced tab, enter the following settings.

Table 11 Gateway Advanced Tab Settings

Field Setting

Call Connect Mode OnAnswer

Destination for 
Unroutable PBX Calls

<the extension of an attendant who will receive calls to Cisco Unity that are 
unanswered>

Turn MWI On FAC <blank>

Turn MWI Off FAC <blank>

Wait for 
Ringback/Connect on 
Blind Transfer

Yes

Hunt Group Extension <the pilot number for the Cisco Unity voice messaging ports>

Signaling Digit Relay 
Mode

Off

Voice Activity 
Detection

Off

Frame Size Click the applicable setting:

• G.711—20

• G.729a—10

Caution Failure to use the correct setting will result in recorded messages 
containing nothing but silence.

Frames Per Packet Click the applicable setting:

• G.711—1

• G.729a—2

Caution Failure to use the correct setting will result in recorded messages 
containing nothing but silence.

Call Control QOS 
Byte

(PIMG units connect only to a LAN) 0

(PIMG units connect to a WAN) 104

Note For details on the setting for a LAN, see the caveat CSCsb96387.

RTP QOS Byte (PIMG units connect only to a LAN) 0

(PIMG units connect to a WAN) 184

Note For details on the setting for a LAN, see the caveat CSCsb96387.
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Step 34 Click Apply Changes.

Step 35 Click the Gateway Capabilities tab.

Step 36 Depending on how you have planned to use the voice messaging ports, click the applicable setting for 
each port in the Telephony Port Capability column.

Caution In setting up the PIMG unit, do not send calls to ports in Cisco Unity that cannot answer calls 
(voice messaging ports that are not set to Answer Calls). For example, if a voice messaging 
port is set only to Dialout MWI, do not send calls to it. Otherwise the integration will not 
function correctly.

If a port in Cisco Unity is disabled, click No in the Telephony Port Enabled column for the corresponding 
port on this tab. Note that changing a setting in the Telephony Port Enabled column requires restarting 
the PIMG unit.

Step 37 Click Apply Changes.

Step 38 On the Configure menu, click SIP.

Step 39 On the SIP page, enter the following settings.

Table 12 Gateway Capabilities Tab Settings

Telephony Port Capability Settings Voice Messaging Port Usage

Calls-Only The port will answer incoming calls only and will not dial out 
(for example, to set MWIs or send message notifications).

MWIs-Only The port will dial out only (for example, to set MWIs or send 
message notifications) and will not answer incoming calls.

Both The port will answer incoming calls and will also dial out (for 
example, to set MWIs or send message notifications).

Table 13 SIP Page Settings

Field Setting

Host and Domain Name <the domain name of the PIMG unit>

Server Port 5060

Primary Proxy Server Address (Cisco Unity without failover) <the IP address of the Cisco Unity 
server>

(Cisco Unity with failover configured) <the IP address of the 
primary Cisco Unity server>

Primary Proxy Server Port 5060

(When you configure more than one PIMG unit, increase this setting 
by 1 for each successive unit. For example, unit 2 will be 5061, 
unit 3 will be 5062, and so on. For failover, this setting must match 
the setting for the Backup Proxy Server Port field.)
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Step 40 Click Apply Changes.

Step 41 On the Configure menu, click IP.

Step 42 On the IP page, enter the following settings.

Step 43 Click Apply Changes.

Step 44 On the Configure menu, click Tones.

Step 45 On the Tones page, click the Learn tab.

Caution Destination addresses cannot be duplicated in the same session. Otherwise, the process for 
learning tones will not succeed. If you do not have enough available phones to learn all the 
tones at one time, you can run multiple sessions to learn tones individually by checking or 
unchecking the applicable Acquire Tone check boxes.

Backup Proxy Server Address (Cisco Unity without failover) Not applicable; leave the default 
setting.

(Cisco Unity with failover configured) <the IP address of the 
secondary Cisco Unity server>

Backup Proxy Server Port (Cisco Unity without failover) Not applicable; leave the default 
setting.

(Cisco Unity with failover configured) 5060

(When you configure more than one PIMG unit, increase this setting 
by 1 for each successive unit. For example, unit 2 will be 5061, 
unit 3 will be 5062, and so on. For failover, this setting must match 
the setting for the Primary Proxy Server Port field.)

Proxy Query Interval 10

T1 Time 400

T2 Time 3000

Table 14 IP Page Settings

Field Setting

Client IP Address <the new IP address you want to use for the PIMG unit>

(This is the IP address that you will enter in UTIM when you create the 
integration.)

Client Subnet Mask <the new subnet mask, if the subnet mask is different from the default IP 
address>

Default Network 
Gateway Address

<the IP address of the default network gateway router that the PIMG units will 
use>

BOOTP Enabled No

Table 13 SIP Page Settings (continued)

Field Setting
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Step 46 On the Tones page, for the Dialtone event, confirm that the Acquire Tone check box is checked and leave 
the Destination Address field blank.

Step 47 On the Tones page, for the Busy Tone event, confirm that the Acquire Tone check box is checked and do 
the following substeps to verify that the tone is correct.

a. From a available phone, call a second phone.

b. Answer the second phone when it rings, and leave both handsets off so that both phones are busy.

c. From a third phone, dial one of the busy phones.

d. Confirm that you hear a busy tone.

e. Hang up the third phone but leave the handsets for the other two phones off.

Step 48 On the Tones page, in the Destination Address field for Busy Tone, enter the extension that you dialed 
in Step 47c. from the third phone.

Step 49 On the Tones page, for the Error/Reorder Tone event, confirm that the Acquire Tone check box is 
checked and do the following substeps to verify that the tone is correct.

a. From an available phone, dial an extension that does not exist.

b. Confirm that you hear the reorder or error tone.

c. Hang up the phone.

Step 50 On the Tones page, in the Destination Address field for Error/Reorder Tone, enter the extension that you 
dialed in Step 49a.

Step 51 On the Tones page, for the Ringback Tone event, confirm that the Acquire Tone check box is checked 
and do the following substeps to verify that the tone is correct.

a. From an available phone, dial an extension that does exist

b. Confirm that you hear the ringback tone.

c. Hang up the phone.

Step 52 On the Tones page, in the Destination Address field for Ringback Tone, enter the extension that you 
dialed in Step 51a.

Step 53 Click Learn.

Note When running learn tones, the PIMG unit will restart after learning the first tone. For details, see 
the caveat CSCsh53791.

Step 54 When the process is complete, check the check box for each newly learned tone and click Apply.

Step 55 Hang up the phones that you used in Step 47.

Step 56 On the Configure menu, click Restart.

Step 57 On the Restart page, click Restart Unit Now.

Step 58 When the PIMG unit has restarted, in the View menu, click Refresh.

Step 59 Repeat Step 2 through Step 58 on all remaining PIMG units.
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Creating a New Integration with the Avaya S8700 Phone System
After ensuring that the Avaya S8700 phone system and the Cisco Unity server are ready for the 
integration, do the following procedures to set up the integration and to enter the port settings.

To Create an Integration

Step 1 If UTIM is not already open, on the Windows Start menu of the Cisco Unity server, click Programs > 
Cisco Unity > Manage Integrations. UTIM appears.

Step 2 In the left pane of the UTIM window, click Cisco Unity Server.

Step 3 On the Integration menu of the UTIM window, click New. The Telephony Integration Setup Wizard 
appears.

Step 4 On the Welcome page, click Circuit-switched via Intel PIMG and click Next.

Step 5 On the Name the Phone System Integration page, accept the default name or enter the phone system 
name to identify this integration, then click Next.

Step 6 On the Enter PIMG Settings page, click Add.

Step 7 In the Add PIMG dialog box, enter the following settings, then click OK.

Step 8 Repeat Step 6 and Step 7 for each remaining PIMG unit that you are connecting to the Cisco Unity 
server.

You can press the following buttons to modify, delete, or verify the PIMG units that you are connecting 
to the Cisco Unity server.

Table 15 Settings for the Add PIMG Dialog Box

Field Setting

Display Name <accept the default name or enter another name to identify this PIMG unit>

IP Address <the IP address of this PIMG unit>

SIP Port 5060

Phone Lines (Ports) 
Connected

8

<if you want to use fewer than eight voice messaging ports, enter the number 
of ports (or phone lines) that you want to use with this PIMG unit>

Table 16 Buttons on the Enter PIMG Settings Page

Button Action

Add Displays the Add PIMG dialog box to add another PIMG unit to the 
integration.

Modify Displays the Modify PIMG dialog box so that you can modify the settings of 
the selected PIMG unit.

Delete Deletes the selected PIMG unit from the integration.

Ping Servers Confirms that the IP address is correct for all PIMG units.

Licensing Displays a list of the licensed, used, and available voice messaging ports on the 
Cisco Unity server.
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Step 9 On the Enter PIMG Settings page, click Next.

Step 10 On the PIMG Integration with the PBX page, click No, the PIMGs Do Not Require a Serial 
Connection to the PBX, then click Next.

Step 11 On the Configure Cisco Unity SIP Settings page, enter the following settings, then click Next.

Step 12 If other integrations already exist, the Enter Trunk Access Code page appears. Enter the extra digits that 
Cisco Unity must use to transfer calls through the gateway to extensions on the other phone systems with 
which it is integrated. Then click Next.

Step 13 (Cisco Unity 4.2 and later only) On the Reassign Subscribers page, any subscribers whose phone system 
integration has been deleted and who are not currently assigned to a phone system integration will appear 
in the list.

If no subscribers appear in the list, click Next and continue to Step 14.

Otherwise, select the subscribers that you want to assign to this phone system integration and click Next. 
You can use the following selection controls for selecting subscribers.

Step 14 (Cisco Unity 4.2 and later only) On the Reassign Call Handlers page, any call handlers whose phone 
system integration has been deleted and that are not currently assigned to a phone system integration will 
appear in the list.

If no call handlers appear in the list, click Next and continue to Step 15.

Otherwise, select the call handlers that you want to assign to this phone system integration and click 
Next. You can use the following selection controls for selecting call handlers.

Table 17 Settings for the Configure Cisco Unity SIP Settings Page

Field Setting

Contact Line Name (Cisco Unity without failover) <the voice messaging line name that subscribers 
use to contact Cisco Unity and that Cisco Unity will use to register with the 
PIMG units>

(Cisco Unity with failover configured) <the name the primary Cisco Unity 
server; this setting must match the Port X Endpoint parameter settings in the 
PIMG administration; this setting must be the same for both the primary and 
the secondary Cisco Unity servers>

Cisco Unity SIP Port <the IP port on Cisco Unity that callers and the SIP server use to connect to 
voice mail; we recommend using the default setting>

Preferred Codec <the codec Cisco Unity will first attempt to use on outgoing calls>

Table 18 Selection Controls for the Reassign Subscribers Page

Selection Control Effect

Check All Checks the check boxes for all subscribers in the list.

Uncheck All Unchecks the check boxes for all subscribers in the list.

Toggle Selected For the subscribers highlighted in the list, toggles between checking and 
unchecking the check boxes.

If some highlighted subscriber check boxes are checked and others are 
unchecked, clicking this button will check all the check boxes. Clicking again 
will uncheck all the check boxes.
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Step 15 On the Completing page, verify the settings you entered, then click Finish.

Step 16 At the prompt to restart the Cisco Unity services, click Yes. The Cisco Unity services restart.

Alternatively, you can restart the Cisco Unity services in UTIM on the Tools menu by clicking Restart 
Cisco Unity.

To Enter the Voice Messaging Port Settings for the Integration

Step 1 After the Cisco Unity services restart, on the View menu, click Refresh.

Step 2 In the left pane of the UTIM window, expand the phone system integration that you are creating.

Step 3 In the left pane, click the name of the first PIMG unit.

Step 4 In the right pane, click the Ports tab.

Step 5 Enter the settings shown in Table 20 for the voice messaging ports.

For best performance, use the first voice messaging ports for incoming calls and the last ports to dial out. 
This helps minimize the possibility of a collision, in which an incoming call arrives on a port at the same 
time that Cisco Unity takes the port off-hook to dial out.

Caution In programming the phone system, do not send calls to voice messaging ports in Cisco Unity 
that cannot answer calls (voice messaging ports that are not set to Answer Calls). For example, 
if a voice messaging port is set only to Message Notification, do not send calls to it.

Table 19 Selection Controls for the Reassign Call Handlers Page

Selection Control Effect

Check All Checks the check boxes for all call handlers in the list.

Uncheck All Unchecks the check boxes for all call handlers in the list.

Toggle Selected For the call handlers highlighted in the list, toggles between checking and 
unchecking the check boxes.

If some highlighted call handler check boxes are checked and others are 
unchecked, clicking this button will check all the check boxes. Clicking again 
will uncheck all the check boxes.

Table 20 Settings for the Voice Messaging Ports

Field Considerations

Extension Enter the extension for the port as assigned on the phone system.

Enabled Check this check box to enable the port. The port is enabled during normal operation.

Uncheck this check box to disable the port. When the port is disabled, calls to the port get a 
ringing tone but are not answered. Typically, the port is disabled only by the installer during 
testing.

Answer Calls Check this check box to designate the port for answering calls. These calls can be incoming 
calls from unidentified callers or from subscribers.
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Step 6 Click Save.

Step 7 Click the SIP Info tab.

Step 8 (Cisco Unity 4.2 and later) Uncheck the Register with SIP Server check box and click Save.

(Cisco Unity 4.0 and 4.1) Uncheck the Register with Proxy Server check box and click Save.

Step 9 At the prompt to restart the Cisco Unity services, click No.

Step 10 Repeat Step 3 through Step 9 for all remaining PIMG units.

Step 11 In the left pane, click Properties for the phone system.

Step 12 In the right pane, click the PIMG tab.

Step 13 Under Set Messaging Waiting Indicators (MWI) Using This Method, click In-Band with Port Memory.

Step 14 Click Save.

Step 15 At the prompt to restart the Cisco Unity services, click Yes.

Step 16 After the Cisco Unity services restart, exit UTIM.

Caution Do not edit the phone configuration file (also known as the switch ini file) to customize this integration. 
If you change the settings in this file, the integration may not function correctly.

Note If your recording volume needs adjusting, you can change the recording gain for the PIMG units. For 
instructions, see the “Appendix: Adjusting the Recording Gain for PIMG Units” section on page 28.

Message Notification Check this check box to designate the port for notifying subscribers of messages. Assign 
Message Notification to the least busy ports.

Dialout MWI

(not used by serial or SMDI 
integrations)

Check this check box to designate the port for turning MWIs on and off. Assign Dialout MWI 
to the least busy ports.

AMIS Delivery

(available with the AMIS 
licensed feature only)

Check this check box to designate the port for making outbound AMIS calls to deliver voice 
messages from Cisco Unity subscribers to users on another voice messaging system. 
Cisco Unity supports the Audio Messaging Interchange Specification (AMIS) protocol, 
which provides an analog mechanism for transferring voice messages between different 
voice messaging systems.

This setting affects outbound AMIS calls only. All ports are used for incoming AMIS calls.

Because the transmission of outgoing AMIS messages may tie up voice ports for long 
periods of time, you may want to adjust the schedule on the Network > AMIS > Schedule 
page so that outgoing AMIS calls are placed during closed hours or at times when 
Cisco Unity is not processing many calls.

TRAP Connection Check this check box so that subscribers can use the phone as a recording and playback 
device in Cisco Unity web applications and e-mail clients. Assign TRAP Connection to the 
least busy ports.

Table 20 Settings for the Voice Messaging Ports (continued)

Field Considerations
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Testing the Integration
To test whether Cisco Unity and the phone system are integrated correctly, do the following procedures 
in the order listed.

If any of the steps indicate a failure, refer to the following documentation as applicable:

• The installation guide for the phone system.

• Cisco Unity Troubleshooting Guide, available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_troubleshooting_guides_list.html.

• The setup information earlier in this guide.

To Set Up the Test Configuration

Step 1 Set up two test extensions (Phone 1 and Phone 2) on the same phone system that Cisco Unity is 
connected to.

Step 2 Set Phone 1 to forward calls to the Cisco Unity pilot number when calls are not answered.

Caution The phone system must forward calls to the Cisco Unity pilot number in no fewer than four 
rings. Otherwise, the test may fail.

Step 3 In the Cisco Unity Administrator, create a test subscriber to use for testing by doing the applicable 
substeps below.

If your message store is Microsoft Exchange, do the following:

a. In the Cisco Unity Administrator, go to the Subscribers > Subscribers > Profile page.

b. Click the Add icon.

c. Select New Exchange Subscriber.

d. On the Add Subscriber page, enter the applicable information.

e. Click Add.

If your message store is IBM Lotus Domino, do the following:

a. In the Cisco Unity Administrator, go to the Subscribers > Subscribers > Profile page.

b. Click the Add icon.

c. Click Notes.

d. In the Address Book list, confirm that the address book listed is the one that contains the user data 
that you want to import.

If the address book that you want to use is not listed, go to the System > Configuration > 
Subscriber Address Books page and add a different address book.

e. In the Find Domino Person By list, indicate whether to search by short name, first name, or last 
name.

f. Enter the applicable short name or name. You also can enter * to display a list of all users, or enter 
one or more characters followed by * to narrow your search.

g. Click Find.

h. On the list of matches, click the name of the user to import.

i. On the Add Subscriber page, enter the applicable information.
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j. Click Add.

Step 4 In the Extension field, enter the extension of Phone 1.

Step 5 In the Active Schedule field, click All Hours - All Days.

Step 6 Click the Save icon.

Step 7 In the navigation bar, click Call Transfer to go to the Subscribers > Subscribers > Call Transfer page 
for the test subscriber.

For more information on transfer settings, refer to the “Subscriber Template Call Transfer Settings” 
section in the Cisco Unity Administrator Help.

Step 8 Under Transfer Incoming Calls, click Yes, Ring Subscriber’s Extension, and confirm that the extension 
number is for Phone 1.

Step 9 Under Transfer Type, click Release to Switch.

Step 10 Click the Save icon.

Step 11 In the navigation bar, click Messages to go to the Subscribers > Subscribers > Messages page for the test 
subscriber.

Step 12 Under Message Waiting Indicators (MWIs), check Use MWI for Message Notification.

Step 13 In the Extension field, enter x.

Step 14 Click the Save icon.

Step 15 Open the Status Monitor by doing one of the following:

• In Internet Explorer, go to http://<Cisco Unity server name>/web/sm.

• Double-click the desktop shortcut to the Status Monitor.

• In the status bar next to the clock, right-click the Cisco Unity tray icon and click Status Monitor.

To Test an External Call with Release Transfer

Step 1 From Phone 2, enter the access code necessary to get an outside line, then enter the number outside 
callers use to dial directly to Cisco Unity.

Step 2 On the Status Monitor, note which port handles this call.

Step 3 When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting 
means that the port is configured correctly.

Step 4 Confirm that Phone 1 rings and that you hear a ringback tone on Phone 2. Hearing a ringback tone means 
that Cisco Unity correctly released the call and transferred it to Phone 1.

Step 5 Leaving Phone 1 unanswered, confirm that the state of the port handling the call changes to “Idle.” This 
state means that release transfer is successful.

Step 6 Confirm that, after the number of rings that the phone system is set to wait, the call is forwarded to 
Cisco Unity and that you hear the greeting for the test subscriber. Hearing the greeting means that the 
phone system forwarded the unanswered call and the call-forward information to Cisco Unity, which 
correctly interpreted the information.

Step 7 On the Status Monitor, note which port handles this call.

Step 8 Leave a message for the test subscriber and hang up Phone 2.

Step 9 On the Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This state 
means that the port was successfully released when the call ended.
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Step 10 Confirm that the MWI on Phone 1 is activated. The activated MWI means that the phone system and 
Cisco Unity are successfully integrated for turning on MWIs.

To Test Listening to Messages

Step 1 From Phone 1, enter the internal pilot number for Cisco Unity.

Step 2 When asked for your password, enter the default password. Hearing the request for your password means 
that the phone system sent the necessary call information to Cisco Unity, which correctly interpreted the 
information.

Step 3 Confirm that you hear the recorded voice name for the test subscriber (if you did not record a voice name 
for the test subscriber, you will hear the extension number for Phone 1). Hearing the voice name means 
that Cisco Unity correctly identified the subscriber by the extension.

Step 4 When asked whether you want to listen to your message, press 1.

Step 5 After listening to the message, press 3 to delete the message.

Step 6 Confirm that the MWI on Phone 1 is deactivated. The deactivated MWI means that the phone system and 
Cisco Unity are successfully integrated for turning off MWIs.

Step 7 Hang up Phone 1.

Step 8 On the Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This state 
means that the port was successfully released when the call ended.

To Set Up Supervised Transfer on Cisco Unity

Step 1 In the Cisco Unity Administrator, go to the Subscribers > Subscribers > Call Transfer page.

If the name of the test subscriber is not displayed, click the Find icon (the magnifying glass) in the title 
bar, then click Find, and select the name of the test subscriber in the list that appears.

For more information on transfer settings, refer to the “Subscriber Template Call Transfer Settings” 
section in the Cisco Unity Administrator Help.

Step 2 Under Transfer Type, click Supervise Transfer.

Step 3 Set the Rings to Wait For field to 3.

Step 4 Click the Save icon.

To Test Supervised Transfer

Step 1 From Phone 2, enter the access code necessary to get an outside line, then enter the number outside 
callers use to dial directly to Cisco Unity.

Step 2 On the Status Monitor, note which port handles this call.

Step 3 When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting 
means that the port is configured correctly.

Step 4 Confirm that Phone 1 rings and that you do not hear a ringback tone on Phone 2. Instead, you should 
hear the indication your phone system uses to mean that the call is on hold (for example, music or beeps).
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Step 5 Leaving Phone 1 unanswered, confirm that the state of the port handling the call remains “Busy.” This 
state and hearing an indication that you are on hold mean that Cisco Unity is supervising the transfer.

Step 6 Confirm that, after three rings, you hear the greeting for the test subscriber. Hearing the greeting means 
that Cisco Unity successfully recalled the supervised-transfer call.

Step 7 During the greeting, hang up Phone 2.

Step 8 On the Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This state 
means that the port was successfully released when the call ended.

To Delete the Test Subscriber

Step 1 In the Cisco Unity Administrator, go to the Subscribers > Subscribers > Profile page.

If the name of the test subscriber is not displayed, click the Find icon (the magnifying glass) in the title 
bar, then click Find, and select the name of the test subscriber in the list that appears.

Step 2 In the title bar, click the Delete Subscriber icon (the X).

Step 3 Click Delete.

Integrating a Secondary Server for Cisco Unity Failover
For Cisco Unity 4.1 and later, the Cisco Unity failover feature enables a secondary server to provide 
voice messaging services when the primary server becomes inactive. For information on installing a 
secondary server for failover, refer to the applicable Cisco Unity installation guide, available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html.

The Cisco Unity failover feature is not available when this phone system is integrated with 
Cisco Unity 4.0 through PIMG units.

For information on Cisco Unity failover, refer to the Cisco Unity Failover Configuration and 
Administration Guide. The Domino version of the guide is available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/products_feature_guide_book09186a00803f
70f3.html. The Exchange version of the guide is available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/products_feature_guide_book09186a00801
b9241.html.

Requirements
The following components are required to integrate a secondary server:

• One secondary server for each primary server installed and ready for the integration, as described in 
the applicable Cisco Unity installation guide and earlier in this integration guide.

• A license that enables failover.
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Integration Description
The Avaya S8700 phone system sends call information and voice connections through the digital lines 
to the PIMG units. The PIMG units communicate with the primary and secondary servers through the 
LAN or WAN by using Session Initiation Protocol (SIP). Figure 2 shows the required connections.

Figure 2 Connections Between the Phone System and the Cisco Unity Servers

The primary and secondary servers act in the following manner:

• When the primary server is operating normally, the secondary server is inactive.

• When the primary server becomes inactive, the secondary server becomes active.

• When the primary server becomes active again, the secondary server becomes inactive.

Setting Up the Secondary Server for Failover
Do the following procedure to integrate the secondary server.

To Set Up the Secondary Server for Failover

Step 1 Install a secondary server with the same configuration as the primary server. For installation instructions, 
refer to the applicable Cisco Unity installation guide.

Step 2 On the Windows Start menu of the secondary server, click Programs > Cisco Unity > Manage 
Integrations. The UTIM window appears.

Step 3 On the Integration menu of the UTIM window, click New. The Telephony Integration Setup Wizard 
appears.

Step 4 Enter the settings to match the integration settings on the primary server.

Note We recommend not reassigning any unassigned subscribers and call handlers to the new 
integration, if you are asked by the wizard. Failover replication will automatically assign the 
correct integration.
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Step 5 At the prompt to restart the Cisco Unity services, click Yes.

Note When restarting the Cisco Unity services, use the UTIM prompt instead of the Cisco Unity icon 
in the Windows taskbar. The taskbar icon does not restart all of the Cisco Unity services.

Step 6 After Cisco Unity restarts, on the Windows Start menu of the Cisco Unity server, click Programs > 
Cisco Unity > Manage Integrations. UTIM appears.

Step 7 In the left pane of the UTIM window, click the phone system integration that you created in Step 3.

Step 8 For Cisco Unity 4.0 and 4.1, continue to Step 9.

For Cisco Unity 4.2 and later, do the following substeps.

a. In the right pane, click Properties.

b. On the Integration tab, compare the setting of the Integration ID field for the secondary server to the 
setting of the Integration ID field for the primary server.

c. If the integration IDs of the phone system on the primary and secondary server are the same, 
continue to Step 9.

If the integration IDs of the phone system on the primary and secondary servers are different, on the 
secondary server, click Modify Integration ID.

d. When cautioned that subscribers associated with the current Integration ID setting will not be 
automatically associated with the new Integration ID setting, click OK.

e. In the Modify Integration ID dialog box, in the Enter New Integration ID field, enter the Integration 
ID setting for the phone system on the primary server and click OK.

f. Click Save.

g. At the prompt to restart the Cisco Unity services, click Yes.

h. In the left pane, click the phone system integration that you created in Step 3.

Step 9 In the right pane, click the Ports tab.

Step 10 Enter the port settings to match the port settings on the primary server.

Caution In programming the phone system, do not send calls to voice messaging ports in Cisco Unity 
that cannot answer calls (voice messaging ports that are not set to Answer Calls). For example, 
if a voice messaging port is set only to Message Notification, do not send calls to it.

Step 11 Click Save.

Step 12 Repeat Step 9 through Step 11 for each remaining PIMG unit in the phone system integration.

Step 13 Exit UTIM.

Changing the Settings for an Existing Integration
After the integration is set up, if you want to change any of its settings (for example, to add or remove 
voice messaging ports for an integration), do the following procedure.
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To Change the Settings for an Integration

Step 1 On the Cisco Unity server, on the Windows Start menu, click Programs > Cisco Unity > Manage 
Integrations. The UTIM window appears.

Step 2 In the left pane, double-click Unity Server. The existing integrations appear.

Step 3 Click the integration you want to modify.

Step 4 In the right pane, click the name of the cluster, phone system, or PIMG unit (depending on your 
integration) for the integration.

Step 5 In the right pane, click the applicable tab for the integration.

Step 6 Enter new settings in the fields that you want to change.

Caution If you are adding or removing voice messaging ports, make sure you change the settings for 
the individual ports so that there are an appropriate number of ports set to answer calls and an 
appropriate number of ports set to dial out.

Step 7 In the UTIM window, click Save.

Step 8 If prompted, restart the Cisco Unity services.

Caution Do not edit the phone configuration file (also known as the switch ini file) to customize this integration. 
If you change the settings in this file, the integration may not function correctly.

Deleting an Existing Integration
If you want to delete an existing integration (for example, you have replaced the phone system with 
which Cisco Unity originally integrated), do the following procedure.

To Delete an Existing Integration

Step 1 On the Cisco Unity server, on the Windows Start menu, click Programs > Cisco Unity > Manage 
Integrations. The UTIM window appears.

Step 2 In the left pane, double-click Unity Server. The existing integrations appear.

Step 3 Click the integration that you want to delete.

Step 4 On the Integration menu, click Delete.

Step 5 Follow the on-screen instructions to assign the subscribers of the deleted phone system integration to 
another phone system integration.

Step 6 At the prompt to restart the Cisco Unity services, click Yes. The Cisco Unity services restart.

Alternatively, you can restart the Cisco Unity services in UTIM on the Tools menu by clicking Restart 
Cisco Unity.

Step 7 If the integration you deleted used voice cards, remove the voice cards from the Cisco Unity server.
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Alternate Extensions
Appendix: Adjusting the Recording Gain for 
PIMG Units

If recordings are too quiet or too loud, do the following procedure to adjust the recording gain for the 
PIMG units.

To Adjust the Recording Gain for PIMG Units

Step 1 In a web browser, go to http://<IP address of PIMG unit>.

Step 2 On the System Login page, enter the user name and password.

Step 3 Click Log On.

Step 4 Go to http://<IP address of PIMG unit>/dsp.htm.

Step 5 In the TDM to IP Gain field, increase the value to make recordings louder, or lower the value to make 
recordings quieter.

Caution Increasing the recording gain too much can cause the PIMG unit to fail to recognize DTMF 
tones, which will result in integration problems. If DTMF recognition problems occur after 
increasing the recording gain, decrease the value in the TDM to IP Gain field.

Step 6 Click Apply Changes.

Step 7 Repeat Step 1 through Step 6 for all remaining PIMG units.

Appendix: Using Alternate Extensions and MWIs

Alternate Extensions
In addition to the “primary” extension that you specify for subscribers, you can assign subscribers up to 
nine alternate extensions. (The primary extension is the one that you assign to each subscriber when you 
create his or her subscriber account; it is listed on the Subscribers > Subscribers > Profile page.) 

Reasons to Use Alternate Extensions

There are several reasons that you may want to specify alternate extensions for subscribers. For example, 
if you have more than one Cisco Unity server that accesses a single, corporate-wide directory, you may 
want to use alternate extensions to simplify addressing messages to subscribers at the different locations. 
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Alternate Extensions
With alternate extensions, the number that a subscriber uses when addressing a message to someone at 
another location can be the same number that the subscriber dials when calling. You may also want to 
use alternate extensions to:

• Handle multiple line appearances on subscriber phones.

• Offer easy message access on direct calls from a cell phone, home phone, or phone at an alternate 
work site (assuming that the phone number is passed along to Cisco Unity from these other phone 
systems). In addition, when such phones are used as alternate extensions, and are set to forward to 
Cisco Unity, callers can listen to the subscriber greeting, and leave messages for the subscriber just 
as they would when dialing the primary extension for the subscriber.

Tip To reduce the number of requests from subscribers who want alternate extensions set up for 
multiple cell phones, home phones, and other phones, give subscribers class of service (COS) 
rights to specify their own set of alternate extensions. (See the Subscribers > Class of Service > 
Profile page.) With proper COS rights, a subscriber can specify up to five alternate extensions 
in the Cisco Unity Assistant—in addition to the nine that you can specify on the Subscribers > 
Alternate Extensions page in the Cisco Unity Administrator.

• Enable URL-based extensions in Cisco Unity for an integration with a SIP phone system.

How Alternate Extensions Work

Before you set up alternate extensions, review the following list for information on how alternate 
extensions work:

• Alternate extensions cannot exceed 30 characters in length. By default, each administrator-defined 
alternate extension must be at least 3 characters in length, while subscriber-defined alternate 
extensions must be at least 10 characters. 

You can use the Advanced Settings tool in Tools Depot to specify a minimum extension length for 
the extensions entered in the Cisco Unity Administrator and the Cisco Unity Assistant. Refer to the 
Advanced Settings Tool Help for details on using the settings. Respectively, the settings are 
Administration—Set the Minimum Length for Locations, and Administration—Set the Minimum 
Length for Subscriber-Defined Alternate Extensions.

• You can control whether subscribers can use the Cisco Unity Assistant to view the alternate 
extensions that you specify in the Cisco Unity Administrator. To do so, see the Subscribers > Class 
of Service > Profile page. The Subscriber-Defined Alternate Extension table displays the alternate 
extensions that the subscriber adds.

• Neither the Cisco Unity Administrator nor the Cisco Unity Assistant will accept an extension that 
is already assigned to another subscriber (either as a primary or alternate extension), or to a public 
distribution list, call handler, directory handler, or interview handler. Cisco Unity verifies that each 
alternate extension is unique—up to the dialing domain level, if applicable—before allowing either 
an administrator or a subscriber to create it.

• All alternate extensions use the same transfer settings as the primary extension. 

• In many cases, Cisco Unity can activate a message waiting indicator (MWI) for an alternate 
extension. However, depending on the phones and phone systems involved, some additional phone 
system programming may be required to set this up.

Setting Up Alternate Extensions
Do the applicable procedure to add, modify, or delete alternate extensions:
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Alternate MWIs
• To Add Administrator-Defined Alternate Extensions, page 30

• To Modify or Delete Alternate Extension(s), page 30

To Add Administrator-Defined Alternate Extensions

Step 1 In the Cisco Unity Administrator, go to any Subscribers > Alternate Extensions page.

Step 2 In the Administrator-Defined Alternate Extensions table, enter an extension in any row. When entering 
characters in the Alternate Extensions table, consider the following:

• You can enter an extension up to 30 characters in length. (SIP integrations can use up to 30 
alphanumeric characters.)

• Each extension must be unique—up to the dialing domain level, if applicable.

• Enter digits 0 through 9. Do not use spaces, dashes, or parentheses.

• For SIP integrations, you can also enter a valid alias for a SIP URL. For example, if the URL is 
SIP:aabade@cisco.com, enter aabade. Do not use spaces.

• Rows are numbered as a convenience. You can enter alternate extensions in any order, and you can 
have blank rows.

Step 3 Repeat Step 2 as necessary.

Step 4 Click the Save icon. Alternate extensions are enabled for all rows in the table.

To Modify or Delete Alternate Extension(s)

Step 1 In the Cisco Unity Administrator, go to any Subscribers > Alternate Extensions page.

Step 2 Do any of the following:

• To modify an extension, change the extension in the Alternate Extensions table.

• To delete extensions, check the check boxes next to the alternate extensions that you want to delete.

• To remove all alternate extensions listed in the table, click Select All.

Step 3 Click the Save icon.

Step 4 Repeat Step 2 and Step 3 as necessary.

Note You can run the Cisco Unity Bulk Import wizard when you want to add alternate extensions for multiple 
subscribers at once. When you do, the Cisco Unity Bulk Import wizard appends the new alternate 
extensions to the existing table of alternate extensions, beginning with the first blank row.

Alternate MWIs
You can set up Cisco Unity to activate alternate MWIs when you want a new message for a subscriber 
to activate the MWIs at up to 10 extensions. For example, a message left at extension 1001 can activate 
the MWIs on extensions 1001 and 1002.
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Alternate MWIs
Cisco Unity uses MWIs to alert the subscriber to new voice messages. MWIs are not used to indicate 
new e-mail, fax, or return receipt messages.

Setting Up Alternate MWIs
Cisco Unity can activate alternate MWIs. Note that depending on the phones and phone systems, some 
additional phone system programming may be necessary. Refer to the installation guide for the phone 
system.

To enable alternate MWIs for extensions, do the following procedure for each subscriber who needs 
alternate MWIs.

To Set Up Alternate MWIs for Extensions

Step 1 In the Cisco Unity Administrator, go to the applicable Subscribers > Subscribers > Messages page.

Step 2 Confirm that the Use MWI for Message Notification check box is checked.

Step 3 Click the Add button located beneath the MWI Extensions table to add a row to the table. By default, 
the first row in the table contains an “X” to indicate the primary extension assigned to a subscriber. If 
you want one more extension and do not need to activate the MWI on the primary extension, you can 
also modify the first row.

Step 4 Enter the applicable extension in the Extension field of the table. MWIs are automatically enabled for 
all rows in the table. When entering characters in the MWI Extensions table, consider the following:

• Enter digits 0 through 9. Do not use spaces, dashes, or parentheses.

• Enter , (comma) to insert a one-second pause.

• Enter # and * to correspond to the # and * keys on the phone.

Step 5 Click the Save icon.

Step 6 Repeat Step 3 through Step 5 as necessary.

Note You can run the Cisco Unity Bulk Import wizard when you want to set up alternate MWIs for multiple 
subscribers at once.

To change or delete alternate MWIs for extensions, do the following procedure.

To Modify or Delete Alternate MWIs

Step 1 In the Cisco Unity Administrator, go to the applicable Subscribers > Subscribers > Messages page.

Step 2 Do either of the following:

• To modify an extension, change the extension in the MWI Extensions table.

• To delete extensions, check the check boxes next to the rows that you want to delete in the MWI 
Extensions table, and then click the Delete button.

Step 3 Click the Save icon.
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Alternate MWIs
Step 4 Repeat Step 2 and Step 3 as necessary.

Appendix: PIMG Integrations Over a WAN That 
Use the G.729a Codec Must Disable Comfort 
Noise

When the PIMG units connect to a WAN and use the G.729a codec, you must disable comfort noise. 
Otherwise, callers will hear loud comfort noise after pressing a DTMF key or between prompts when 
recording a message.

To Disable Comfort Noise

Step 1 On the Cisco Unity server, on the Start menu, click Run.

Step 2 In the Run dialog box, enter regedit and click OK.

Caution Changing the wrong registry key or entering an incorrect value can cause the server to 
malfunction. Before you edit the registry, confirm that you know how to restore it if a problem 
occurs. (Refer to the “Restoring” topics in Registry Editor Help.) Note that for a Cisco Unity 
failover system, registry changes on one Cisco Unity server must be made manually on the 
other Cisco Unity server, because registry changes are not replicated. If you have any 
questions about changing registry key settings, contact Cisco TAC.

Step 3 If you do not have a current backup of the registry, save the registry settings to a file by doing the 
following depending on the Windows version:

Step 4 Expand the registry key
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\Avaudio\Parameters
and double-click the ComfortNoise value in the right pane.

Step 5 In the Edit DWORD Value dialog box, under Base, click Decimal.

Step 6 In the Value Date field, enter 128.

Step 7 Click OK.

Step 8 Exit the Registry Editor.

Step 9 Restart the Cisco Unity server.

Windows 2003 Click File > Export.

Windows 2000 Click Registry > Export Registry File.
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Conventions
Step 10 If you are using failover, repeat this procedure to apply the registry setting to the secondary Cisco Unity 
server.

Appendix: Documentation and Technical 
Assistance

Conventions
The Avaya S8500/S8700 PIMG Integration Guide for Cisco Unity 4.0 uses the following conventions.

The Avaya S8500/S8700 PIMG Integration Guide for Cisco Unity 4.0 also uses the following 
conventions:

Table 21 Avaya S8500/S8700 PIMG Integration Guide for Cisco Unity 4.0 Conventions

Convention Description

boldfaced text Boldfaced text is used for:

• Key and button names. (Example: Click OK.)

• Information that you enter. (Example: Enter Administrator in the User 
Name box.)

< > 

(angle brackets)

Angle brackets are used around parameters for which you supply a value. 
(Example: In the Command Prompt window, enter ping <IP address>.)

- 

(hyphen)

Hyphens separate keys that must be pressed simultaneously. (Example: Press 
Ctrl-Alt-Delete.)

> 

(right angle 
bracket)

A right angle bracket is used to separate selections that you make:

• On menus. (Example: On the Windows Start menu, click Settings > Control 
Panel > Phone and Modem Options.)

• In the navigation bar of the Cisco Unity Administrator. (Example: Go to the 
System > Configuration > Settings page.)

[x]

(square brackets)

Square brackets enclose an optional element (keyword or argument). (Example: 
[reg-e164])

[x | y]

(vertical line)

Square brackets enclosing keywords or arguments separated by a vertical line 
indicate an optional choice. (Example: [transport tcp | transport udp])

{x | y}

(braces)

Braces enclosing keywords or arguments separated by a vertical line indicate a 
required choice. (Example: {tcp | udp})
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Appendix: Documentation and Technical Assistance
Obtaining Documentation, Obtaining Support, and Security Guidelines
Note Means reader take note. Notes contain helpful suggestions or references to material not covered in the 
document.

Caution Means reader be careful. In this situation, you might do something that could result in equipment 
damage or loss of data.

For descriptions and URLs of Cisco Unity documentation on Cisco.com, see the Cisco Unity 
Documentation Guide. The document is shipped with Cisco Unity and is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/about/aboutdoc.htm.

Obtaining Documentation, Obtaining Support, and Security 
Guidelines

For information on obtaining documentation, obtaining support, providing documentation feedback, 
security guidelines, and also recommended aliases and general Cisco documents, see the monthly 
What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical 
documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any examples, command display output, and 
figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses in illustrative content is unintentional and 
coincidental.
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